
SAS® Lineage Viewer 2.1: User’s 
Guide

About SAS Lineage Viewer

SAS Lineage Viewer enables you to better understand the relationships between objects in your Viya 
applications. These objects include data, transformation processes, reports, and visualizations.

After you select an object as a subject, the application displays a network diagram. This diagram shows the 
subject that you selected and all of its related objects. These relationships between the subject and the other 
objects are stored in the Relationship Service. You can use SAS Lineage Viewer to perform the following tasks:

n “Search for a Subject” on page 2

n “Work with Views” on page 2

n “Review Object or Relationship Details” on page 7

n “Work with Saved View Filters” on page 8

For insight into the content of the views that you work with in SAS Lineage Viewer, see “Sample Lineage 
Network Diagrams” on page 12.

Getting Started with SAS Lineage Viewer

Sometimes you know the name of an object and need to explore its relationships with other objects. In this case, 
you can open SAS Lineage Viewer and use the Search for a Subject window. For detailed instructions, see 
“Search for a Subject” on page 2.

Other times, you might see an object in another SAS Viya application and want to see it in the context of its 
relationships with other objects. If that SAS Viya application supports the Relationship Service, you can select 
the object and bring it up directly in a SAS Lineage Viewer network diagram. Follow these steps in SAS Projects:

1 Go to the Data window for a project and right-click an object, such as the __APRIL_NEW table.

2 Click Actions ð Explore Lineage in the contextual menu.

If relationship data for the selected object exists in the Relationship Service, the object is displayed as the 
subject of a network diagram in SAS Lineage Viewer.



Search for a Subject

1 Select the Search window in SAS Lineage Viewer to search for the subject of a network diagram. This 
window is displayed when you log on to SAS Lineage Viewer. 

Note: Click Cancel to access an empty SAS Lineage Viewer window.

2 Enter a string in the Search field, and click . The Results table is populated with every object that contains 
the string that you entered. These objects consist of all tables and files that have been loaded into memory 
from any of your SAS Viya applications that contribute to the relationship service.

3 To refine your search and limit the number of results, use the tools in the Filter search by section. The 
filtering tools that you can use are summarized in the following table: 

Filtering Tools

Filter Type Information to Enter Where to Enter Information Results

One or more specific data 
types

The object types that 
you want to include

The check boxes next to the 
object types ( )

The objects that contain the 
selected data types are 
displayed.

One or more objects 
modified at a specified 
time

Start and end dates The Start date and End date 
fields in the Date Modified 
section

The objects that were modified 
between the selected start and 
end dates are displayed.

4 Set an object-type filter, a date-modified filter, both types of filters, or no filters at all. Click Apply after you set 
the filters to see the filtered results.

5 (Optional) Click  to see a list of recent searches. Click a search in the list to perform the search again.

6 (Optional) Click  to enable or disable extended searches for the Object Type filter. Extended searches 
include all of metadata related to these object types, so they can take a long time.

7 (Optional) When you have found one or more subjects for network diagrams, select the check box next to the 
objects. Then click Open to open the network diagram. A separate view is opened for each of the selected 
subjects. Each view shows its subject and all of the objects that are related to it.

Work with Views

1 Select a subject in the Search window. See “Search for a Subject” on page 2.

Each of the subjects that you select and open in the Search window is displayed in a separate network 
diagram.

2 Click one of the selected subject names listed at the top of the SAS Lineage Viewer window. (You can click 
these names to switch between views.) The following figure shows the top level of a network diagram:
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Network Diagram

Review the contents of the network diagram. For example, this view consists of a subject, SALARY, and the 
items that have a relationship with it.

3 Click the expand and collapse control on objects in the view to see the nodes beneath them. The following 
display shows an expanded view that contains the nodes beneath the SALARY.sashdat and the 
CASUSER(prluin) objects:

Expanded Network Diagram

Note: The subject of the view is always marked by the highlighting applied to its name. This highlighting 
always contrasts with the background of the view and the formatting of the names of the other objects in the 
view. The name of the file SALARY in this particular view is formatted with white type against a black 
background. These colors can change when you use a different theme.
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4 Click the  button at the bottom left side of a view to see a Relationships window. This window explains how 
the lines between the objects in the view represent the relationships between the objects. For example, a 
solid line with no arrow represents an equal relationship between two objects. The available relationships are 
shown in the following figure:

These relationship types are described in the following table:

Relationship 
Types Description

Is equal to Applications modeling the same objects from different systems. An object is equal to another 
when it represents the same object when it is accessed through another method or system. See 
“Work with Equivalent and Clustered Objects” on page 9.

Contains Any applications modeling the inner workings of a top-level entity. An object contains another 
object when the included object does not make sense or exist without the object that contains it. 
Example: Table to Column

Is synonymous with Applications modeling objects that have the same connotations, implications, or reference. An 
object is synonymous to another object if it is alike in meaning or significance.

Is parent of Applications modeling derived object hierarchy. An object is the parent of any object who cannot 
be located or found within a hierarchy without the parent object.

Is dependent on Any applications modeling a depends on relationship between entities. An object depends on an 
object when it cannot function or be defined without that related object being present. Example: 
Job to Table

Is associated with Applications modeling loosely related objects. An object is associated with another object 
through some other known or unknown system or method. Example: Table to Table (FK to PK)

5 Click File in the menu bar. The File menu enables you access functions that affect SAS Lineage Viewer as a 
whole. You can perform the following functions:

n Search for subjects

n Open recent views
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n Refresh the current view

n Quickly access a series of landmarks with the application, such as the Application Bar, Search, the list of 
open views, and the property pane.

6 Click Object in the menu bar. The Object menu provides access to functions that affect selected objects in a 
view. The following table lists these functions:

Object Menu Functions

Menu Item Function

Details Displays detailed information about a selected object. For information, see 
“Review Object or Relationship Details” on page 7.

Lineage Displays a view that has the selected object as the subject.

Recluster selected Recluster selected removes a selected unclustered object from the network 
diagram and places it back into a cluster.

Recluster all removes all unclustered objects from the network diagram and 
places them back into a cluster.

Uncluster (0) item displays a selected object in the network diagram.

See “Work with Equivalent and Clustered Objects” on page 9.

Recluster all

Uncluster 0 item

Merge equivalents Merges or separates equivalent objects. Equivalent objects are files that contain 
the same data but are housed in different database formats. For example, an 
Oracle file that is converted to a CSV file with the same data is equivalent to the 
CSV file. Another example is a Server that has an equivalent Map Server. See 
“Work with Equivalent and Clustered Objects” on page 9.

Separate equivalents

Expand Expands a selected object to show the objects nested beneath it.

Collapse Collapses a selected object to return to the original view that contains it.

Filter Filters the object type of a selected object or the relationship type between two 
objects from the view. You can restore the object type or relationship type by 
resetting it in the Filter pane and clicking Apply.

Hide selection Hide selection prevents an object from the view from being displayed in the 
view.

Unhide selection Unhide selection restores the visibility of the object in the view. The subject of 
the network diagram cannot be hidden.

Actions Provides access to related applications.

7 Click View in the menu bar. The View menu provides functions related to the current view and any view 
filters that you have saved, as covered in the following table:

View Menu Functions

Menu Item Function

New view Creates and saves a view filter.

View properties Reviews the properties of the current view.
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Menu Item Function

Manage view filters Manages your view filters.

Diagram view Switches between the views available in the network 
diagram (such as the All Relationships view and any 
saved views that you have created).

Filter panel Filters the content of the current view.

Collapse all Collapses all of the nodes that you have expanded.

Zoom level Changes the zoom level of the current view.

Reset layout Resets the current view to the default layout.

8 Review the toolbar at the top of the window. You can switch to a related application, view recent items, view 
the Help for SAS Lineage Viewer, and log off from the application. You can use the list of opened views in the 
toolbar below it to quickly switch between the views.

9 Review buttons on the menu bar and the right side of the SAS Lineage Viewer window. These buttons give 
you access to the functions listed in the following table:

Function Buttons

Name Button Function

Find Finds objects in the current view.

View lineage Creates a new view with a selected object as the subject.

Auto-layout Automatically straightens the layout of the current view.

Collapse all Collapses all of the nodes that you have expanded.

Zoom Zooms the current view in or out, using buttons or a slider. 
Also resets to the default zoom level.

Show pane Opens the most recently opened pane.

Hide pane Closes the most recently opened pane.

Object details Displays the Details pane for a selected object.

Manage view 
filters

Manages your view filters.

Filter Displays the Filter pane, where you can set or reset filters 
on the current view.

Hidden objects Displays the Hidden Objects pane, where you can hide 
or show objects.
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Review Object or Relationship Details

1 Select an object in a network diagram.

2 Click  to view detailed information in the Details pane. The following figure shows the Details pane for an 
object:

Details Pane for an Object

3 Select a relationship in a network diagram.

4 Click  to view detailed information in the Details pane. The following figure shows the Details pane for a 
relationship:
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Work with Saved View Filters

You can create and save a filter that controls the objects included in an existing view. Then, you can work with 
this saved view filter at a later time.

1 Click .

2 Click  to access the New View Filter window. 

3 Enter the name, relationship types, objects, and behaviors that you want to include in the saved view filter.

Note: The behavior of the selected items is specified in the drop-down menus. The available behaviors are 
Enabled in the filter panel, Disabled in the filter panel, and Hidden in the filter panel.

A completed New View Filter window is shown in the following figure:

New View Filter
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4 Click Save to save the view filter and display the filtered view.

5 Click  to manage the view filters that you have saved. The Manage View Filters pane is shown in the 
following display: 

Manage View Filters

Work with Equivalent and Clustered Objects

Equivalent and clustered objects are marked with contrasting circular badges in the lower right corner of their 
icons. Equivalent objects are displayed as merged or separated, and clustered objects can be seen in a 
clustered or an unclustered state. In the merged or clustered state, a single object represents all of the 
equivalent or clustered object in a network diagram. In the separate or unclustered state, all of the objects are 
displayed in the diagram.

Merged Equivalent Objects

Equivalent objects contain the same data, but they are contained in different formats.
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Both the CAS table object named CAR_VIEW_ORA and the ORACLE_TARG object in the network diagram 
above have equivalent objects. You can recognize this state of equivalence by the badge in the lower right 
corner of the icons. This badge specifies the number of equivalent objects in the equivalence.

Equivalent objects can be shown in a merged state. This means that only one of the two or more equivalent 
items are shown in the network diagram. The other items are indicated by the number on the object icon.

Separated Equivalent Objects

Right-click an object that has an equivalence badge on it, and click Separate equivalents. A new network 
diagram that shows all of the equivalent objects for the selected object is displayed. Highlight the path between 
two equivalent objects, and the relationship label Is equal to is displayed. The equivalent items are also 
listed in the Details pane.

Right-click any of the objects in a separated equivalence, and click Merge equivalences to merge the objects 
back into a single object.
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Description of Equivalence

Click on the line between two objects, and click  to see an explanation of the relationship between the objects 
in the Details pane, as shown above.

Clustered Objects

Objects are clustered based on their types, relationship to the expanded object, and direction of that 
relationship. Clusters form when enough objects of the same type are related to the expanded object with the 
same relationship type and relationship direction. These objects are clustered together as one node in the 
diagram.

Specifically, clusters contain: ten or more objects, only objects of the same type, and only objects that are 
related to the same object with same type of relationship.

Clustered objects are displayed in a network diagram as a single object that has a badge in the lower right 
corner of the object icon. This badge displays the number of items in the cluster. This network diagram contains 
two clustered objects that are named File and Table.
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Unclustered Objects

Expand a cluster by double-clicking a clustered object. In this case, the Table object has been unclustered. Each 
one of the ADDRESSES0x tables in the network diagram is an object that is included in the Table cluster.

When a clustered object is expanded, it displays all of the relationships that its member objects are a part of, 
except relationships between member objects. Expanding a clustered object is similar to expanding each 
member object individually. Once a clustered object has been expanded, those objects should be added to the 
diagram in a fully expanded state when any of its members are unclustered.

If a clustered object has not been expanded, any member objects that are added to the diagram are displayed in 
a collapsed state. The only exception is when all of the objects to which that member object is related are 
already present on the diagram. However, if you expand a cluster group that contains an object that has circular 
references to other objects, this object with the circular references must be separated from this cluster group. An 
example of a circular reference is an Object A that is related to Object B. Object B, in turn, is related to an Object 
C. This Object C is also related to Object A. In this way, all three objects are related.

Sample Lineage Network Diagrams

This topic contains a series of lineage network diagrams. These network diagrams illustrate some of the ways in 
which objects from Viya applications and the relationships between them are depicted in the SAS Lineage 
Viewer application. Each network diagram is followed by a table that contains detailed information about the 
objects in the network diagram. Other types of network diagrams can be generated, but the network diagrams 
here display a variety of the objects and relationships that you can explore in SAS Lineage Viewer.

n “Data Source for DBMS” on page 13

n “Data Interactions in a Network Diagram” on page 14

n “Job Request Network Diagram” on page 15

n “Data Source for a CAS Server” on page 16
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Data Source for DBMS

This network diagram contains the data source ORACLE_TEST, the database schema DMTEST, and the 
database server ed01-scan.unx.sas.com. ORACLE_TEST is a DBMS backed CAS Library.

Data Source Network Diagram

The following table lists key properties of the objects in the network diagram:

Data Source View Object Properties

Name Object Type Object URI Data Source

ORACLE_TEST data source /dataSources/providers/cas/sources/
CAS_Server_ID~ORACLE_TEST

SAS

DMTEST database schema ed01–your.server.com/DMTEST SAS

ed01–your.server.com database server ed01–your.server.com SAS

The URI for a database server varies according to the DBMS type and the data source attributes. These values 
are listed in the following table:

Database Server URI Formatting

DBMS Type Data Source Attributes URI Format

db2 path, db path/db

Oracle path path

lasr server server
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Teradata database, server server/database

Postgres database, server server/database

Impala server server

Hive server server

Data Interactions in a Network Diagram

This network diagram contains the data source COMMON_TEST, which is the parent of the data table 
BATTING. BATTING is used as a source for the SAS table Batting.sashdat. COMMON_TEST is also the parent 
of the external file batting.csv, from which BATTING.sahhdat and BATTING were loaded and created.

Data Interactions Network Diagram

The following table lists key properties of the objects in the network diagram:

Path View Object Properties

Name Object Type Object URI Data Source

COMMON_TEST Data source /dataSources/providers/cas/sources/
CAS_Server_ID~COMMON_TEST

SAS

Batting.sashdat file file:CASServerAddress/net/dmtesting/ifs/
dmt_data/SASViya/Data/Common_Test/
Batting.sashdat

SAS

Batting.csv file file:CASServerAddress/net/dmtesting/ifs/
dmt_data/SASViya/Data/Common_Test/
Batting.csv

SAS
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BATTING table /dataTables/dataSources/
CAS_Server_ID~COMMON_TABLES/
tables/BATTING

SAS

COMMOM_TEST is a data source object that represents a path-backed CAS library. BATTING is used as a 
source for the SAS table Batting.sashdat. This file is usually located within the directory defined by a CAS library 
or data source. The Batting.csv file is a file object in a directory used to load or create a data table and its source 
file. This file is usually located within the directory defined by a CAS library or data source. BATTING is a data 
table object in a data source that is path based.

Job Request Network Diagram

Contacts_Job_201783161048 is a job request used in the execution of a scheduled data movement. Import 
Table-PostgreSQL is a job definition or action template used in execution of the data movement. 
Contactsin.sashdat is a SAS table that contains the inputs to the job. CONTACTS is a CAS table that receives 
the outputs.

Job Request Network Diagram

The following table lists key properties of the job request and job definition objects in the network diagram:

Job Request View Object Properties

Name Object Type Object URI Data Source

CONTACTS_Job_20178316
1048

job request /jobExecution/jobRequests/requestID SAS

Import Table-PostgreSQL job definition jobDefinitions/definitions/definitionID SAS
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Data Source for a CAS Server

This network diagram contains the data source for a CAS server.

CAS Server Network Diagram

Data Source View

Name Object Type Object URL Data Source

CAS_Server_Name data source /dataSources/providers/cas/sources/
CAS_Server_Name

SAS

SAS® and all other SAS Institute Inc. product or service names are registered trademarks or 
trademarks of SAS Institute Inc. in the USA and other countries. ® indicates USA registration. Other 
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